Creating ADA Compliant Instructional Material for Online
Courses

Darshana Juvale, Pinar Celik, & Rebecca O’Connell

Executive Summary

This document includes information on designing ADA (Americans for Disabilities Act) compliant
content for online courses. It is a work in progress put together by a group of instructional designers
at Engineering-LAS Online Learning (ELO). Its primary audience includes instructional designers and
instructors interested in teaching online. It is not a comprehensive guide on designing online courses
for ADA compliance, nor is it certified by lowa State University (ISU). However, initial exploration has
shown that in order to achieve compliance from all instructors, the institution needs multiple

approaches — educating faculty on UDL, providing faculty with Do-It-Yourself ADA tips and resources,
and signing up with a captioning service.

Email the ELO Design Team at elodesign@iastate.edu with your suggestions for improvement.
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BACKGROUND INFORMATION

This document is a work in progress initiated by a group of instructional designers at Engineering-
LAS Learning Online (ELO). The motivation for this work stemmed from the designers' desire to
create quality online courses that are pedagogically sound and accessible to a diverse audience.

After extensive research and testing, ELO designers have developed Do-It-Yourself (DIY) tips and
techniques for designing ADA compliant instructional materials, like images, documents, and
audio/videos. These tips and techniques need to be continually updated.

Additionally, in order to achieve compliancy from all instructors, it is recommended that ISU
educates faculty in UDL (Universal Design for Learning) best practices and invests in a commercial
captioning service. CELT has developed a Blackboard course on UDL that faculty can enroll in to learn
ways of making their course accessible to a diverse audience. Also available is AccessDL (The Center
on Accessible Distance Learning) funded by the U.S. Dept of Education that provides guidance on
making distance learning courses and programs accessible to students and instructors with
disabilities. A list of vendors for closed captioning is included in Appendix A.

This document is organized into two sections:
1) Laws Impacting Web Accessibility and 2) Tips for Creating Accessible Media

LAWS IMPACTING WEB ACCESSIBILITY

There are state and federal laws requiring the University to assure online material is accessible to
current and prospective students and employees. This document deals with ways to make online
courses accessible to all people, regardless of their impairments or situation. Additionally, this
document is designed to help assure the University is meeting its legal obligations when it comes to
web accessibility. Increasing accessibility while managing legal risk is the twofold goal of this
guidance.

At the federal level, the Americans with Disabilities Act (ADA), as amended, is an anti-discrimination
statute designed to ensure equal access to opportunities, programs, and benefits for qualified
individuals with disabilities in education, employment, and other areas.

At the state level, the lowa Civil Rights Act (ICRA) prohibits discrimination on the basis of disability in
both employment and education. This incorporates the right to access information in education,
employment, and other areas.

Common problems with web accessibility create legal risks under both the ADA and the ICRA.

TIPS FOR CREATING ACCESSIBLE MEDIA SECTION INCLUDES:
Audio/Video Accessibility

Document Accessibility

Image Accessibility

Website Accessibility

PwnNpRE

1) Audio/Video Accessibility Tips

Audio and videos need to incorporate features that make them accessible to everyone. Providing
transcripts that can be downloaded and/or closed captions with audio and video are two of the main
ways of making audio/video accessible to hearing and/or vision impaired users. More and more,
closed captioning is becoming a preferred method.
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Closed Captioning of Online Audio and Videos: Closed captions, also known as subtitles, provide
text equivalents of the spoken part in a video. Closed captions are synchronized with the audio and
usually appear at the bottom of the screen. If only audio is available, a transcript is made available
for download.

ADA/ICRA compliance tips: The following are some best practices for closed captions:

Content
* Captions should be accurate. They should fully represent the audio, including speaker
identification and non-speech information. When a speaker stutters, caption what is said.
* Equal — Meaning and intention of the material is completely preserved.
Language
* Spelling and Capitalization — Be consistent in the spelling of words.
*  Punctuation and Grammar — Follow conventional rules of Standard English.
* Hyphens and Dashes
* Nonessential information that needs special emphasis should be conveyed by double
hyphens or a single long dash.
Format
* Consistent — Uniformity in style and presentation. Use a font similar to Helvetica medium
with clear resolution.
* Text Considerate Case — Mixed case characters are preferred.
Display
* Closed captions should be timed to synchronize with the audio. To check for compliancy,
select the Captions options drop down > Show non-compliant duration. This option
highlights any captions in red whose duration is not between three and seven seconds.
* Only one to three lines of text should appear on the screen all at once, stay there for three
to seven seconds, and then replaced by another caption.
* Include not more than 32-charcters per line.
* Lines should be broken at logical points where speech normally pauses, unless it exceeds the
32-characters-per-line requirement.
* Readable — Displayed with enough time to be read completely.
* Placed properly and must not interfere with existing important information. Captions should
not cover up graphics and other essential visual elements of the picture

Creating Closed Captioning: There are multiple ways for creating closed captions. These include
hiring individuals for this purpose, signing up with commercial vendors and/or Do It Yourself (DIY)
options.

* You can outsource the whole process and have commercial vendors create the transcript,
insert time codes to sync with the audio, and upload to the video server. See a list of
vendors in Appendix A.

* Qutsource part of the project — either create the transcript and send it to a vendor for
creating time codes and then upload the transcript with the time codes to the video server,
or

* Do it Yourself (DIY). See accompanying document “Do It Yourself Guide on Creating Closed
Captions”.

2) Document Accessibility concerns the proper formatting of documents for screen readers. (See
more information on Kurweil 3000 screen reader used by ISU Student Disability Office in Appendix
A). Always provide documents in an alternative text-based format, such as HTML or RTF (Rich Text
Format), in addition to PDF. Text-based formats are the most compatible with assistive technologies.
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Resources for creating ADA Compliant PDF, DOC, PPT Files

The National Center on Disability and Access to Education has developed a one-page
accessibility "cheat-sheet" to assist in creating accessible content.

"How to make a Word Document Accessible" by Portland Community College.

“MS Word: Headings” video by Portland Community College

“Acrobat DC” tools make it easy to create accessible PDFs and let you check the accessibility
of existing PDFs.
Ways to make an accessible PDF on Mac: (Resource WAMOE)

e}

o
o
o

o

e}

Start with a well-structured, accessible word document or presentation.

Click the file tab and select save as. In the Save as type field, select PDF.

Enter a file name in the File name field.

Click on options button and make sure the documents structure tags for accessibility
checkbox is checked.

Click OK.

Click Save. This will tag all of the text formatting so page headings and lists are
correctly interpreted by a screen reader.

Scanning a Document to a PDF: Scanning a document means taking a photo of it. Since a
photo of text is not accessible, you will need to run optical character recognition (OCR) on
the scan. This will make the text on the scan readable by assistive technologies.

e}

How to run OCR on a PDF using Adobe Acrobat Pro:
=  Open your PDF file.
= Open the Tools panel (click “Tools” in top right) and click "Recognize text”.
= Click “In this File” and click the “Edit” button to adjust your OCR settings.
= Select the "Language" of the text.
=  For the output style, choose “searchable image” for PDF output style and
down-same too 600 dpi.
= Click Ok when done

Fonts Tips on use of fonts while creating ADA compliant documents:

e}

Ensure your text is readable by using at least 10px san serif fonts, such as Arial,
Helvetica or Verdana. These font types will magnify well for those who have low
vision.

If there is an image with text in it, make sure to put the text in the alternative text
[opens in new window], so it will be accessible to blind students.

Refrain from using floating text boxes, track changes or commenting, because these
features are not accessible.

3) Image Accessibility typically involves adding text description to images that can be read by screen
readers, because screen readers typically skip images on a web page. Adding an image that
constitutes an important part of the content without its text equivalent puts the student with visual
impairment at a disadvantage. Possible solutions include:

Adding a text equivalent to every image, which will enable a user with a vision disability to
understand what it is. The text equivalent can be in the form of:

e}

o
o

An alt text description, which is detected by screen readers, but is not visible to
other users.

Captions for images that describe the image

A description in the text surrounding the image. See examples of Alternative Text
Descriptions for Images

Try not to use only images and/or graphics to convey important content. Images and
graphics should be used to enhance existing text and not constitute the main content.
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4) Website Accessibility tips - see images and audio/video accessibility tips

Use WAVE to check websites for basic levels of accessibility. WAVE is a free designed Web
Accessibility Evaluation Tool.

“Tips for Using WAVE for ADA Compliance” by Temple University Libraries.
* Adding Alternative Text to an image makes that image accessible to the blind. Successful
alternative text description for the image either could be:
o inthe surrounding paragraph text
o an alt text description,
o along description or
o acaption

* Providing the text format for audio files makes them accessible to those with hearing
disability.

*  For colorblind users, the visuals can be tested by converting them to grayscale. As long as
visual elements have hierarchy, they should be comprehensive for those individuals. Check
“Colour Blind Awareness” website for more in- formation regarding the use of colors in your
website.

* Websites should be designed so they can be viewed with the color and font sizes set in
users’ web browsers and operating systems.

Provide audio descriptions of images (including changes in setting, gestures, and other details) to
make videos accessible to people who are blind or have low vision. Provide text captions
synchronized with the video images to make videos and audio tracks accessible to people who are
deaf or hard of hearing. (See options for making videos accessible in the next section).

See US Department of Health and Human Services Guidelines on Creating an ADA-Compliant
Website.
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APPENDIX A
CLOSED CAPTIONING SERVICES

* Caption Solutions (877-674-5800) —wanda@captionsolutions.com

* Automatic Sync Technologies, LLC (877-AST-SYNC), www.automaticsync.com/caption,
info@automaticsync.com

¢  RAMP, www.ramp.com

e REV, www.rev.com

* C(Cielo24, https://cielo24.com/

* 3PlayMedia, http://www.3playmedia.com/

* ProTranscript, http://protranscript.com/faq.html

SCREEN READERS
Screen readers are assistive technology that help users with poor vision navigate a website by
reading aloud text displayed on the computer screen. Kurzweil 3000 is the screen reader used at
lowa State University. Kurzweil 3000 is an integrated scan and read software program that provides
multi- sensory access to reading material with powerful tools for reading, writing, test-taking and
learning. Kurzweil 3000-firefly provides four platform options:

1. Windows

2. Mac

3. ipadapp

4. Web App accessible via web browser

If you need Kurzweil 3000 software on your computer, you can download and install it from one of
these locations:

* For Macintosh

* For Windows

You can use firefly to browse through your Universal Library and read Kurzweil or text files directly
from a computer’s web browser.
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Do It Yourself Guide on Creating Closed Captions

Creating closed captioning is a 3-step process.
1. Create an accurate transcript with punctuation
2. Inserttime codes to sync with audio
3. Upload to the video server

This document includes instructions on creating closed captions using the following software:
YouTube

Camtasia

Dragon Naturally Speaking

Voicethread

Built-in Dictation tool in Mac

i W e

YouTube

YouTube’s closed captioning tool can be useful not only for creating captions for use in
YouTube, but also to export for use in other applications. Below are instructions for adding
closed captions in YouTube and exporting the caption file for use elsewhere.

Part 1: Accessing YouTube
First, you will navigate to YouTube and log in.

1. Go to YouTube and log in. If you do not have a Google account, you will need to sign up
for one. (You will not be able to use your lowa State CyMail account to post videos to
YouTube.)

YouD =- [ aQ ol .- |

B sootont m’”“ X
P 10N Y S Q@

Part 2: Uploading and accessing your video

Once you've logged in to YouTube, you will upload your video and YouTube will process it.
1. Once you are signed in, look at the upper right corner to locate the Upload button (see
image below). Click Upload in order to upload your video.

YOII Q ) Upload

2. Once you click upload, you will be directed to a new page where you can either browse
your computer to upload your video and/or you can drag and drop the file that you
would like to upload to your browser (see image below).
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IMPORT VIDEOS

Import your videos from
I coogler
Import

CREATE VIDEOS
Select files to upload

Webcam capture

Or drag and drop video files Record

% Photo slideshow
@ Create

Public ~

Google+ Hangouts On
Alr

Broadcast
HELP AND SUGGESTIONS

Want to upload videos longer than 15 minutes? Increase your limit Video editor
By submitting your videos to YouTube, you acknowledge that you agree to YouTube's Terms of Service and Community Guidelines.
Please be sure not to violate others' copyright or privacy rights. Leam more Edit

Upload instructions |  Troubleshooting | Mobile uploads

YouTube requires video files, such as MP4s. If you are using Camtasia or any other
screen recording tool that produces a video project file (i.e., .camproj or .prproj), you
will need to export your screen recording as an MP4 file before uploading it to YouTube.

Be sure to set your video’s privacy settings according to your own needs and
preferences. We recommend either the “Unlisted” or “Private” setting if you do not want
the world to view your videos (see image below).

Select files to upload

Or drag awwdeo files

Public ~

Public
Unlisted

Private

Once you've selected a video file to upload, it will take some time for YouTube to upload
and process your video file (see image below). How long this process takes depends on
the Internet connection speed that you are using and the length of your video. Stay on
the upload page until the video has finished uploading or the upload will stop.
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YUII Q Upload Q

UPLOADING 17% 1 minute remaining. X “

n Your video is still uploading. Please keep this page open until it's done.

Basic info Advanced settings

Module 1 Odds 3 Private
Upload status:

Description

Once the upload stage is complete and the processing stage has started, it is safe to close
your browser window. YouTube will process your video on its servers.

([l Tube Q vioad A (g
PROCESSING 91% 1 minute rema*ling x “
. n Click "Done" to confirm. All changes saved.
Basic info Advanced settings
Module 1 Odds 3 Private v
Upload status:
Description

+ Add names, circles, or email address

http:/fyoutu.be/Msnc9g7DOIY

You can access your video through the Creator Studio, available through the user icon in
the top right.

Upload o
Q P a e
n
. 0 subscribers
m Creator Studio {3}
i Add account Sign out

Your video will appear in the list of videos in your YouTube Video Manager.

You{Ili: Q Upload jal S
CREATOR STUDIO Videos [} Search videos Q
!i DASHBOARD Actions ¥ Add to View: Newest v HH =

B ViDEO MANAGER Module 1 Odds 3 ,

n March 27, 2015 11:20 AM &) )
[ vees | (o00 ST 0
Once processing is complete, the video image will be replaced with an image from the

video.

You can also access your video by clicking the “Done” button next to the status indicator
when processing has been completed. This will take you to the summary screen shown
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below.

Yﬂll Q Upload Q z
Module 1 Odds 3 Return to editing
Your video is now ready at http://youtu.be/Msnc9g7DOIY
Video Manager + Add more videos
Adding closed captioning
Once your video has been processed, you will closed caption it. To do this:
1. Editthe video’s settings. You can access the video’s “Info and Settings” screen by clicking
either the video’s “Edit” button in the Video Manager, or the “Return to Editing” button
on the video’s summary screen.
You Q Upload o) z
CREATOR STUDIO Videos B Search videos > I
BE DASHBOARD Actions ¥ View: Newest v 2 =
ER \iDEC MANAGER
- &= g
[ e |
Accessing the Edit Settings screen, option 1: The “Edit” button in the Video Manager
YouQ[[L[3 Q uiosd QG

Module 1 Odds 3 Roturn to editing

Your video is now ready at http:/iyoutu.be/MsncSg97001Y l

Video Manager + Add more videos

Accessing the Edit Settings screen, option 2: The “Return to editing” button on the video’s
summary screen
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2. On the “Info and Settings” screen, click the “Subtitles and CC” button in the top right
portion of the screen.

YouQIILi Q vposd | 0 (G
/‘ Info and Settings '/."' Enhancements f Audio P Annotations o Cards Subtitles and CC hal

Cancel

Module 1 Odds 3

VIDEO INFORMATION

Module 1 Odds 3 <
) Chann: Elo Design
e B fosiasffosloslas faasl Uploaddf time: March 27, 2015 11:20 AM
L] & & L BN S : : :4'2 Duratio 8:06
I vl v wel ol vl v el v} vl Raw file: Module 1 Odds 3.mp4
e (o [ifves 2v v [lvv fiv v}&vv o Views: il 0
L J v v i ve :: :0: i Likes: % 0
v &3 o2 ead I HE XXX Dislikes 0
y L )
Za o [faaliaaltan|ianlianlaal Comments m o
Q ‘ L) L] ANl aa : : :‘: : . s Video URL https:/iyoutu.be/Msnc9g7DOIY
vy viewl vel vel vl vel vel i
2050300’?00900100900"—200’?
< 3 & g (B e e i R
Basic info
Module 1 Odds 3 Private v

3. On the “Subtitles and CC” page, you will be asked to select a language. Select English or
the language of your choice. Once you have selected a language, click the “Set Language”
button in the bottom right portion of the dialog box.

Set video language

What language is spoken most in this video?
You must select a video language before adding sublities or CC.

Select language v Jefault for new uploads
English

col
Search 165 other languages

Abkhazian
Afar.

4. YouTube will attempt to create an automated captioning of your video. When it is
finished, the automated captioning will appear as a button below the section “Add new
subtitles or CC”. It will be listed as “English (automatic)”. Automated captions are only
80% accurate; accuracy decreases with the increase in technical terms in the
video. However, the YouTube generated transcript serves as a useful starting place for
further editing.

Click on the “English (Automated)” bar to edit your automated captions.
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/. Info and Settings /' Enhancements : Audio B Annotations o Cards Subtitles and CC -

Module 1 Odds 3

Add new subtitles or CC v

Video language: English
Change language

The “Subtitles and CC” page with automated captioning completed

5. This will direct you to the transcription page. The video is shown on the left, while the
captions are on the right. Each caption is time stamped.

/ Info and Settings 7" Enhancements & Audio P Annotations Subtitles and CC -

Module 1 Law of Large Numbers

Module 1 Law of Large Numbers 4 English Actions ¥
Subtitles published. Click edit to make revisions Edit
T[ﬂeo /p/—,‘g.,,( - é,b/‘ [ Okay. This is the first
p/p/a/l’-fﬂfl o Lime o ot avent should
bagpen video for MATH 104 online.

— Coin fos3s L‘ap«/(‘) . 50%
And what we're going to talk
about

— Die Yoss o 2 shows np 1/4 dé Yo time

o~ ———————— T — — —

in this video is theoretical probability

and empirical probability,

Okay. This video for MATH 10
is the first online.

and the connection between the two. So

Edit

Send feedback
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6. Click the edit button to make changes to the captions/subtitles.
Module 1 Odds 3

Module 1 Odds 3 4  English Actions v

- Subtitles published. Click edit to make revisions. Edit
[A/L\a+ are 0//-/{5‘./ ) _ .
okay in the studio we are going to
discuss something that is

Odds are cateyorized as od /s ){-;/‘

an y/ 4),///5 9 amst related to probability but it's not

exactly the same

P oo "“{"J"Y of

OAds Lor an event = ErLont

Probubi 1Ry dcpiins
EVGM+ 17

and unfortunately in everyday speech
many people

use one place and the other so we're
talking about artist

and you'll hear people say are jar

okay In the studio we
are going to discuss
something that is

or to their high arts for this for high
odds against us

Edit

7. First, adjust the text. To do this, click the text you wish to adjust. The text will become
editable. After you have made your changes, click outside of the textbox to save your
changes.

// \
z )Ldp 0:02.8 okay in the studio we are going to
0:06.0 discuss something that is]

b E nNne 2 ralatad tn nrahahilibe bk ife nat

8. Next, adjust the timings if needed. There are two ways to do this.

o0 Edit the timing text next to the text items. Click the time you wish to adjust and
type in a new start or end time. The start time cannot overlap with the end time
of the previous caption, and the end time cannot overlap with the start time of
the next caption.

o A5 Lo

0:02.8 okay in the studio we are going to
0:06.7 discuss something that is

o R . £ 0:06.8 related to probabilitv but it's not
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O Or, select the item whose time you wish to adjust in the caption bar below the

video. Blue bars will appear to the left and right of it. Drag the bars to adjust the

times.
Module 1 Odds 3

Module 1 Odds 3

L(/["La+ orc a/laf{j?

Qs are cate orized as 001//5 Q'/‘
“"‘”/ 0’/J5 c‘nja/ﬂsf’

P,,,zoue,‘lf&y oF

OAds Lor an event = Evoent
Probuby | ”{75’1\W5
El/@/}+

okay in the studio we are rejated to and unfortunately in every
going to discuss prpbability but it's speech many people
something ma(’ ngt exactly the

same

[] Pause video while typing

<+ English

Type subtitle K

0:02.8
0:06.0)

0:06.8
0:08.8

0:09.3
0:13.6

0:13.6
0:18.0

0:18.0
0:22.1

oke
dis¢

rele
exe

anc
ma

use
talk

anc

After you are done with your modifications, click the Publish button at the bottom

of the screen to save your changes. If you do not do this, all of your changes will

disappear.

okay In the studio we are related to
going to discuss probability but it's
something that is not exactly the 0:18.0

same

0:22.1

[Z Pause video while typing

Exporting your closed captions for use elsewhere
YouTube captions can be downloaded in a standard captioning file format for use in other video

0:13.6 use one place and the other so we're
0:18.0 talking about artist

and you'll hear people say are jar

Discard edits

production applications and in video streaming sites such as Vimeo. Caption files contain

Publish edits

captioning information about a video. The caption file is stored separately from the video file.

1.

Click “Actions” button on the upper right hand corner of the page. This will open a drop

down menu where you can choose one of several captioning file formats to download.

The .vtt format is a good choice, because it can be used by many applications and video

streaming services.
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4 English Actions v

Unpublish
Subtitles published. Click edit to make revisions
Rename...
Okay. This is the first Delete

Original format

video for MATH 104 online. _

srt

.sbv
And what we're going to talk

about

in this video is theoretical probability
and empirical probability,

and the connection between the two. So
Edit

2. When you select the file format in the “Actions” menu, a file will be downloaded to your
default downloads folder. You will be able to see it in your browser’s list of downloads.

3. Store the video file and the captioning file together for future use.

Camtasia - screen recording software

Camtasia is a screen recording software that supports both manual and auto captioning. Auto
captioning uses speech-to-text technology that automatically creates captions from audio in the
timeline. Click on the links below for details on creating closed captions in Camtasia.

* How to create captions using speech-to-text

* How to create captions manually

* Export caption files when you are finished
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Transcribing a video using Dragon Naturally Speaking
Dragon Naturally Speaking can be used to create transcripts that can be fed into YouTube to add

time codes. Transcribing a video using Dragon NaturallySpeaking requires the following steps:

1. Extractan audio file from your video recording. You can do this using either Camtasia or

the free media viewer VLC.
2. Select a Dragon NaturallySpeaking profile, or create one if you don’t already have one.

3. Transcribe an audio file with Dragon Naturally Speaking and save the transcription as

text file.

4. Polishing the transcript.

a. [optional] Increase the accuracy of Dragon NatuallySpeaking’s transcription and

re-transcribe the audio file.

b. Read the transcript and make final corrections.

1. Extracting audio from a video

There are two ways to extract audio from a video file and save it as an audio file. You

can either use Camtasia or the VLC Player for this task.

Camtasia

To create an audio file containing the sound from a Camtasia project:

1. Open a.camproj file in Camtasia and select File->Produce special->Export audio as...

Produce selection as...

Export audio as...
Export frame as...

Ctrl+D
Ctrl+F

Camtasia Studio - Untitled.camproj

Edit View Play Tools Help
New project Ctrl+N
Open project... Ctrl+0

Recent projects 4

Save project Ctrl+S

the ACM ggmplate and
hair to submit full-length
DC conference

ssions

Save project as...

Export project as zip...

Produce and share...

Produce special

Import media...
Import from Google Drive... - P > »1 0:00:00:00/0:0459:11

Recent recordings

Library B Y, W
Import zipped project... B R IR B
0;00 00:00:20;00

00:00:30;00

Connect mobile device...

Exit

Track 1 m;m the ACM templte and EasyChir to submit full-length IGDOC onfe e
] _ '
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2. Save the audio file in .mp3 format. Be sure to save it in a location where you will be able
to locate it later.

Save Audio As Ex
T . « Docu.. » Camtasia Studio v ¢ Search Camtasia Studio P
Organize v New folder = v @
PN . PN
3 Favorites e Type
= Box Sync L1 772872014 1ZTTPM  File fol
Bl Desktop 8/11/201411:20 AM  Filefol &
& Downloads v < >
File name: | audioFor ranscription v

Save as type: | MP3 Files (*.mp3)

Wave Files (*.wav)
MP3 Files (*.mp3)

Select the .mp3 file format
A

4 Hide Folders

3. When the process is complete, your file will appear in the folder you specified.

C IRFINER Desktop - o IEN
Home  Share  View v
@ v 1 [l Desktop » v ¢ Search
A . A
¢ Favorites Sample Transcripts - Goog
Box S ‘ Internet Shortcut
Jm Box Sync A% | 355 pytes
Deskto
= P Section A_converted
% Downloads MP3 Format Sound
& Google Drive mP3 | 145MB
il Recent places oo v TEST_Camtasia Getting Sta
. m Guide
/M This PC Microsoft PowerPoint 9
i Desktop A VLC media player
‘D ; _4- Shortcut
i Pocuments Fml 105K8
Downloads
* . L] audioForTranscription
i Music MP3 Format, .= oo
= pi 456 MB Item type: MP3 Fo
& Prctures mMps] 4 Size: 4.56 MB
& Videos v < Length: 00:04:59
43 items Availability: Availa

Using VLC to extract audio from an existing video

VLC is a free media player and will allow you to export audio from an existing .mp4 video file.
VLC can be downloaded from VideoLAN. To export audio from an .mp4 video file, do the
following:
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1. Open the VLC media player.

A VLC media player - o IEd

Media Playback Audic Video Subtitle Tools

View Help

e

P e mm [l =%

Q)
2. Select Media->Convert/Save.
Fos VLC media player -
Media | Playback Audio Video Subtitle Tools View Help
»] OpenfFile... Ctrl+0
»| Open Multiple Files... Ctrl+Shift+0
[£J Open Folder... Ctrl+F
@) Open Disc... Ctrl+D
22 Open Network Stream... Ctrl+N
Open Capture Device... Ctrl+C
Open Location from clipboard Ctrl+V
Open Recent Media »
Save Playlist to File... Ctrl+Y
Convert / Save... Ctrl+R
(t#)) Stream... Ctrl+S
Quit at the end of playlist
[& Quit Ctrl+Q

3. Click the “Add” button.
& Open Media ? n
[¥] File @)Disc | %5 Network Capture Device

File Selection

You can select local files with the following list and buttons.

Use a subtitle file

[] show more options

Convert / Save Cancel
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4. Select the .mp4 containing the audio and click “Open”.

& Select one or multiple files n
1 @ » ThisPC » Downloads » v ¢ Search Downloads ped
Organize v New folder =y H @
i Desktop A [ Name ~ Date modified Typ A
Documents
= = B Using the ACM template and EasyCha... MP.
L load = " =
in, Ap —
¥ Music ) g o
. ) Using the ACM template and EasyCha... MP.
=| Pictures - . v
A nnnnledriveeime Anr
H Videos v < >
File name: | Using the ACM template and EasyChairtosu v | | All Files (*.%) v

[] Show more options

Convert /Save |v Cancel

5. Click “Convert/Save” at the bottom of the window. You do not need to make a selection
from the drop down menu beside the “Convert/Save” button.

Open Media ? “

@ File &) Disc 52 Network [ Capture Device

-
F=]

File Selection
You can select local files with the following list and buttons.
C:\Users\eledesign\Downloads\Using the ACM template and EasyC... Add...
Remove
[ use a subtitle file
Browse...

[] Show more options

Convert / Save |v Cancel
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6. Select “Audio - MP3” from the “Profile” menu.

A
[=]

Source

Convert

» IEl

Source: | template and EasyChair to submit fulldength SIGDOC conference submissions (1).mp4

Type: file
Settings
(® Convert

[] pisplay the output
[] peinterlace

Profile

() Dump raw input
Destination

Destination file:

window.

Source

Video - H.264 + MP3 (MP4) v

Video - MPEG-2 + MPGA (T5) A
Video - WMV + WMA (ASF)

Video - DIV3 + MP3 (ASF)

Audio - Vorbis (OGG

Audio - MP3

Audio - MP3 (MP4)

Audio - FLAC

Audio - CD

Video for MPEG4 720p TV/device

Video for MPEG4 1080p TV/device ¥
=4 T

Convert

K R

i

Browse

Cancel

Click the “Browse” button next to “Destination file” in the area at the bottom of the

» IEN

Source: | template and EasyChair to submit fulldength SIGDOC conference submissions (1).mp4

Type: file
Settings
(® Convert

[] pisplay the output
[] peinterlace

Profile
() Dump raw input

Destination

Destination file:

Audio - MP3 v | X %] =

Start

4

Browse

Cancel

In the window that appears, select the folder that will contain the audio file, enter the

name you want the audio file to have, and click “Save”.
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& Save file... n
© v 1 Il Desktop v ¢ Search Desktop Pl
Organize v New folder B ¥ (7)
= Box Sync A ()
Il Desktop H Select a destination folder '
& Downloads
& Google Drive v R v
File name: | audioForTranscription H Give your file a name l v
Save as type: Containers (*.mp3) Click save
4 Hide Folders Save Cancel
Destination file: [ Browse ‘

Start Cancel

9. Click “Start” to begin the conversion process. When you do this, you will be returned to
the VLC media player, which should display a progress bar as your audio file is being
generated.

& Convert ? n

Source

Source: | template and EasyChair to submit fulldength SIGDOC conference submissions (1).mp4
Type: file

Settings
(® Convert

[] pisplay the output
["] peinterlace

Profile Audio - MP3 v | 15| [

() Dump raw input

Destination
Destination file: | C:\Users\elodesign\Desktop\audioForTranscription.mp3 Browse
Q Start Cancel
& Streaming - VLC media player - o iEN

Media Playback Audio Video Subtitle Tools View Help

02:31

| B | F B =% @) =
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10. When the process is complete, your file will appear in the folder you specified.

C IRFINER Desktop - o IEE
Home Share View v 0

@ v 1 [ Desktop » v ¢ Searck
A . A
¢ Favorites Sample Transcripts - Goog
Box S . Internet Shortcut
Ja Box Sync A% | 335 bytes
Deskto
g P ., Section A_converted
& Downloads J) MP3 Format Sound
& Google Drive mpP3 [ 1.45MB

= Recent places <. v TEST_Camtasia Getting Sta
_ Guide

— m Microsoft PowerPoint 97-2

1M This PC
j Desktop A VLC media player
E ™ Shortcut
| Documents P 05 KB
Downloads
e . ] . audioForTranscription
® Music J) 2 ltem t:ype MP3 Fo
= Pictures mpr3 | 4,56 MB Size: 4.56 MB
& Videos v £ Length: 00:04:59
43 items Availability: Availa

2. Selecting or creating a profile in Dragon NatuallySpeaking
The first time you use Dragon NaturallySpeaking, you will need to create a user profile. Your

user profile is created using your/a recording of your voice. It allows Dragon to recognize your

voice and speaking style.
1. When you first open Dragon NaturallySpeaking, the “Open User Profile” dialog box will
appear. If you already have a profile, select the profile name, click “Open,” and skip to
“Transcribe the audio file with Dragon Naturally Speaking”.

& Open User Profile
User Profile ‘ Open
elodesign
Jane Doe el
Rebecca | Propetties... |
New...
Help
Location of user profile: <Default= | Browse..
) 4
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2. Ifyou do not have a profile, click “New” to create a new profile and follow the steps

below.
& Open User Profile ﬂ
User Profile ‘ Open

elodesign Cancel

Properties...
) v

Help

Location of user profile: <Default= Browse...
Z

3. The “Welcome” dialog box will appear. This is the first in a series of dialog boxes that
will guide you through the profile creation process. Click “Next” to continue.

Welcome
@
Welcome to
Nuance
Dragon
NaturallySpeaking

Dragon allows you to create documents, control your computer and interact with the digital world,
all by voice. We'll complete a few customization steps and then you can start using your voice to get
things done.

< Back Next > Cancel

4. Give your profile a name. This is the name that will appear in the list of user profiles.
User Profile Name

@

Name your user profile

Please give this user profile a name to distinguish it from the previously created user profiles.
Most people use their first and last name.

Enter a name:
Jane Doel

<Back Cancel
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5. Select the region you are from and your accent.
Speech Options “

@®

Choose your speech options

Please select your region and accent so that Dragon can understand you better.

Select your region:

Indian Subcontinent
Southeast Asia

Advanced

< Back Cancel
Speech Options “

®

Choose your speech options

Please select your region and accent so that Dragon can understand you better.

Select your region:
United States v

Select your accent:

Advanced

Spanish accented English
Teens
Accent not otherwise specified

<ok s

6. Selectan audio device. You want “Microphone: High Definition Audio Device”, as this
will be the most similar to the device that you used to create your audio.
Choose an Audio Device

@

Choose an audio device

D Microphone: High Definition Audio Device (Front Jack)

Other available audio devices:

@ Dragon Remote Microphone Application

U Handheld or smartphone with recording application
H Digital audio recorder (incudes .wav, .mp3, .wma, .dss, .ds2)

< cacs

7. Position your microphone as recommended. You will be using it to record a brief test
recording. Click “Next”.
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Check Microphone

@

Position your microphone properly

Adjust your microphone so the listening part is 1
inch from the corner of your mouth. You may
need to bend the boom to achieve this position.

If you are using your laptop's built-in microphone,
position yourself 1-2 ft. (30-60 cm.) directly in front
of the microphone.

Cancel

8. Click “Start”, and read the text shown. When Dragon NatuallySpeaking has heard
enough, a check mark with the word “Complete” will appear at the bottom of the dialog
box and the “Next” button will become active. Click the button to continue.

Check Microphone | x|

@

Check Microphone | ~ |

Read text to configure your microphone Read text to configure your microphone

- nd

o o
your microphone. your microphone.

1am reading this text out loud, clearly and naturally. | will continue to use this tone when | 1am reading this text out loud. clearly and naturally. | will continue to use this tone when |
dictate with the product. dictate with the product.

Right now. | am giving Dragon a chance to adapt to my voice and audio environment. As |

Right now, | am giving Dragon a chance to adapt to my voice and audio environment. As |
talk, Dragon s checking the quality of the audio input and adjusting some settings

talk, Dragon s checking the quality of the audio input and adjusting some settings.

Good audio input is essential for accurate speech recognition. To achieve high accuracy, | Good audio input is essential for accurate speech recognition. To achieve high accuracy, |
should maintain a consistent distance between my mouth and the microphone. I should should maintain a consistent distance between my mouth and the microphone. I should
also minimize background noise. also minimize background noise.

Dragon's website contains more tips, as well as short videos. Dragon's website contains more tips, as well as short videos.

1 will read this text from the beginning until the Complete prompt appears 1 will read this text from the beginning until the Complete prompt appears.

start Listenin

<Back Next > Cancel

Check Microphone

Read text to configure your microphone

Dragon needs to confirm your properly. then read the
your microphone.

1 am reading this text out loud, clearly and naturally. | will continue to use this tone when |
dictate with the product.

Right now, | am giving Dragon a chance to adapt to my voice and audio environment. As |
talk, Dragon s checking the quality of the audio input and adjusting some settings.

Good audio input is essential for accurate speech recognition. To achieve high accuracy, |
should maintain a consistent distance between my mouth and the microphone. I should

also minimize background noise.

Dragon's w

site contains more tips, as well as short videos.

1 will read this text from the beginning until the Complete prompt appears.

&/ complete

<Back Next > Cancel

9. Dragon will process your sample recording and automatically move on to a dialog box in
which it asks if you want to send data about your usage practices to the company that
makes Dragon. Select the options you want and click “Next”.

Processing.. Accuracy | ~ |

@ ) @
Dragon is customizing itself for you Help us improve Dragon

You can improve Dragon by sending your usage data to us periodically. We keep your data
secure and confidential.

Preparing user profile: Jane Doe Data Collection sends speech, text, and associated data to Nuance Communications, Inc,, a
United States company, to tune, enhance and improve the speech recognition and other
components of this and future products and sevices

. — B

end my usage data

o not send my usage data but remind me about this later

0 not send my usage data
Once this step is complete, Dragon will move to the next step automatically.

If you are in the U.S.: Read our privacy statement here
If you are outside of the U.S.: Read our privacy statement here

Back Next >
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10. Click “Finish” to complete the profile setup process.

@

Dragon is ready for you!

Ve recommend you explore Dragon's Interactive Tutorial, which will appear when you click Finish.

For important details on new features and additional training resources, please see the Help menu.

<o

3. Transcribe the audio file with Dragon NaturallySpeaking and save the

transcript as text file
In this step, you will create a text transcription file in Dragon NaturallySpeaking’s DragonPad

and save the resulting text as a plain text document. You will need a plain text document to
upload to video captioning services such as YouTube.
Transcribing your audio file in DragonPad
1. Once you've created or opened your profile(s), a small interface will appear at the top of
your screen. Hover over the interface to see the full Dragon NatuallySpeaking menu.

2. By default, Dragon NatuallySpeaking will only add punctuation when a punctuation
command such as “period” or “comma” is uttered. There is a formatting option that you
can turn on that will tell Dragon to add periods and commas based on the length of your
pauses. It is very important to activate this option when you are transcribing audio
from a video recording. To activate the “add commas and periods” option:

a. Select “Auto-Formatting Options” from the “Tools” menu.

Now listening for...

(S i.‘ ’ 0 ? Dictation & Commands ~

DragonBar Profile Tools Vocabulary Help =

DragonPad...

Dictation Box...
Transcribe Recording...
Add New Command...
Command Browser...

Recogpnition History...

Administrative Settings...

Auto-Formatting Options...
Options...
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b. Select “Automatically add commas and periods” and click “OK”.

7/ Auto-Formatting
[v] Automatically format text
Web and e-mail addresses [¥] Units of measure
Street addresses [[]1S0 cumency codes
Abbreviate titles [v] Phone numbers
Dates [v] Prices
Dates As Spoken v [v] Times
["] Common abbreviations [] UK and Canadian postcodes
[] Expand contractions [] Other numbers

“million" instead of “,000,000" [C1US Social Security Numbers
[ Numbers, if greater than or equal to | 10 v

[v] Automatically add commas and periods p

["]Insert two spaces after period
Alow pauses in formatted phrases

[T Caps Lock key overrides capitalization commands

Restore defaults
OK Cancel Help

3. To begin transcribing your recording, select “Transcribe Recording” from the Tools
menu.

Now listening for...

(S a; ’ g ‘ ? Dictation & Commands ~

DragonBar Profile Tools Vocabulary Audio Help =
DragonPad...
Dictation Box...
Transcribe Recording...
Add New Command...
Command Browser...

Recognition History...

Administrative Settings...

Auto-Formatting Options...

Options...

4. Dragon NaturallySpeaking will ask you how you wish to transcribe your document.
Select “Transcribe text into DragonPad” and “Only Dictation commands”. Click “Next” to
continue.
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1 Transcribe | x |

Personalize how you transcribe

S

Dragon can transcribe your text into DragonPad or a window that you choose:
* Transcribe text into DragonPad
(U Let me choose the window

Choose the commands that Dragon will recognize when transcribing your text:

®) Only Dictation commands ("New Line™, "All Caps™, etc., see Help for full list)
Dictation commands plus “Scratch That™ and "Resume with™

All commands (not recommended)

Note: If you aren't sure what to select here, just accept the defaults. You can also modify these
options by selecting the "Options™ button on the next screen.

See Help for more information about these settings and other important options that affect accuracy.

["]Don't show this screen again.

-] e |

5. Click “Browse to locate file”. Dragon NatuallySpeaking will display a dialog box where
you can navigate to the audio file that you created in “Extracting audio from a video”
step earlier. Select the file and click “Open”.

i Transcribe [ x|

Transcribe a recorded audio file @

Select the audio file you would like Dragon to transcribe.
File name: l:l Browse to locate file

After you choose a file, select "Transcribe' to begin the transcription process.
If you would like to change options that affect transcription, select "Options”.

Options

Note: There may be a slight delay after you select "Transcribe". DragonPad will appear and
you'll see text transcribed into it. If you chose to transcribe to a different window,

you'll be given the opportunity to select it first. It's important not to use your keyboard

or mouse while Dragon transcribes to that window.

See Help for more information.

Cancel
Fl Transcribe
Transcribe a recorded audio file @
Select the audio file you would like Dragon to iansciibe
File name: Browse ta locate file
(5} Open
@, ~ 4 [l Desktop v ¢ Search Desktop P
Organize v New folder H @
¢ Favorites A O audioForTranscription @
- MP3 Format Sound
J Box Sync mp3| 456M8 \ B
elect a file
I Desktop Box Sync to preview.
& Downloads } Shortcut
& Google Drive @ m 1.50Ke
S n .o FIREIT AL 4 Cancel
File name: v| | Audio Files (*wav; *.mp3; *wmr v
Open \ Cancel
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6. Click “Transcribe” to begin transcribing the audio file.

G Transcribe

Transcribe a recorded audio file

Select the audio file you would like Dragon to transcribe.

File name: C:\Users\elodesign\Desktop\audio Browse to locate file

After you choose a file, select "Transcribe' to beain the transcription process.
If you would like to change options that affect transcription, select "Options".

“ Transcribe

MNate: There may be a slight delay after you select "Transcribe". DragonPad will appear and
you'll see text transcribed into it. If you chose to transcribe to a different window,

you'll be given the opportunity to select it first. [t’s important not to use your keyboard

or mouse while Dragon transcribes to that window.

See Help for more information.

Cancel

7. The transcribed text will appear in Dragon NaturallySpeaking’s built-in text editor,
DragonPad. DragonPad will appear automatically when transcription starts. When
transcription is complete, the “Transcribing” message window will clear.

@ DragonPad - Document = =
File Edit
DEd & alrada

Al (Westem) vz v|B r u @|El= =;

g‘,..‘,.‘4‘,..‘,;.‘,..‘,;.‘,..‘,

- Conference submissions must use the ACM template and be submitted using the easy chair submission
system the same template is used for all say full-length submissions and extended abstracts but not for initial
proposals the template is available as a Microsoft Word document on the ACM proceedinas templates page

the URL for the page is in this video's d Transcribing es various
formatting conventions at the site.templ ieveral types of
metadata that should be added to your Transcribing... Please Wait s general
terms and keywords each metadata ha rs must be
selected from the ACM computing clas Cancel ge you will find

a link to an HTML document containing ..o —.... - ..o ... ..o

Jane Doe

Exporting a text file containing your transcribed text
1. To save the text in DragonPad, click File->Save.
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a. Select the folder that you want the transcript to be saved to, and select “Text

Document” from the “Save as type” options.

@ DragonPad - Document - o
File Edit View Format Help
8 Save As [ x|
®© ~ 1 m» ThisPC » Desktop v & SearchDesktop »
o
Organize v Newfolder e ——
. A Neme ’ Date modified Type (A| pu Submitied the
1 Favorites. you've logged into
J= BoxSync eflexive pronouns M Filefol  submission in the
B Desktop %n;mm pcc 1 o + ci.e ™ ONONthe right side
N IS > ation about
& Document .| lonthatis not
e name: may have Artie been
Save as type: |Rich Text Format (RTF) v| tfilled out if they
Rich Text Format (RTF) he same keywords
© HideFotd onference. The list
ide Folders | Text Document - MS-DOS Format it with your

- . - . ssions authors
check allitems that apply. The category indicates what type of submission you'e submitting. Once you
updated your information, click update information to submit your updates, you will be taken to confirmation
screen. Next, submit your Microsoft Word document. If you take your initial proposal in the abstract field. The
menu on the left will have an add file option if you uploaded a file containing your initial proposal. The menu
on the left will have an update file option select, choose file and then select your Microsoft Word document. If
there is an existing document the Microsoft Word document you are uploading will replace it. Once you have
submitted your updated file, you'll receive a confirmation email. Once you have your confirmation email. If you
have completed the process

Jane Doe

b. Give your transcript a name and click “Save”.

@ DragonPad - Document - g8
File Edit View Format Help

@ Save As

@© =~ 1 lm>» ThisPC » Desktop » v & [ Search Desktop s
| D
Organize v New folder = @
= ; ~
A Name Date modified Type A DU submitted the

¢ Favorites

you've logged into

Js Box Sync Ch13-Reflexive pronouns Vi Filefol  submission in the
B Desktop Gtat 29 Nelete nn At Tet File i ¥ ONON the right side
S N 4 IS > ation about

File name: transcnptOfAudlo’ . Tonthatis not

may have Artie been
Save as type: | Text Document v rfilled out if they

he same keywords
“ Hide Folders Cancel g{‘ ‘f;i:ﬁr;’%eu,rThe list
O . - . ssions authors
check all items that apply. The category indicates what type of submission you're submitting. Once you
updated your information, click update information to submit your updates, you will be taken to confirmation
screen. Next, submit your Microsoft Word document. If you take your initial proposal in the abstract field. The
menu on the left will have an add file option if you uploaded a file containing your initial proposal. The menu
on the left will have an update file option select, choose file and then select your Microsoft Word document. If
there is an existing document the Microsoft Word document you are uploading will replace it. Once you have

submitted your updated file, you'll receive a confirmation email. Once you have your confirmation email. If you
have completed the process

Jane Doe

c. When the “You are about to save the document in text-only format...” message

displays, click the “Text Document” button to confirm that you want a plain text

document.

(] DragonPad - Document = =

File Edit View Format Help
DR & @i
Arial (Westem) vz v|B 7 u@\ |

proposal you'll log into easy chair using the login and password that you establish when you submitted the ~
proposal. If you need a password reminder, you can request one on the login page. Once you've logged into
easy chair, you'll be taken to the default author page you should see a link to your orlglvnal submission in the

3

menu at the * e ) : n right side
of the scre¢ Dragon NaturallySpeaking I
submissior not
already fille L You are about to save the document in text-only format, which will all fomatting. Save Documentas  Artie been
filedinwhe <%= if they
need chan¢ ceywords
that you us! VAT ] 3 The list
of topics in ur

submission. Your submission group refers to the professional backgrounds of your submissions authors
check all items that apply. The category indicates what type of submission you're submitting. Once you
updated your information, click update information to submit your updates, you will be taken to confirmation
screen. Next, submit your Microsoft Word document. If you take your initial proposal in the abstract field. The
menu on the left will have an add file option if you uploaded a file containing your initial proposal. The menu
on the left will have an update file option select, choose file and then select your Microsoft Word document. If
there is an existing document the Microsoft Word document you are uploading will replace it. Once you have
submitted your updated file, you'll receive a confirmation email. Once you have your confirmation email. If you
have completed the process

Jane Doe

d. Your newly created file will appear in the folder you specified.
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4. Polishing the Transcript
Increasing the accuracy of Dragon NatuallySpeaking’s transcription
A document transcribed using the technique described above should have good recognition, but
it will not be perfect. Potential problem areas include:
e Acronyms
e Specialized terminology
e Dragon NaturallySpeaking misinterpreting specific words

These issues can be addressed by adding words and acronyms that Dragon NaturallySpeaking
isn’t recognizing to Dragon NaturallySpeaking’s Vocabulary Editor. The Vocabulary Editor can
also be used to train Dragon NaturallySpeaking to recognize how you say certain words.
Adding words to Dragon NaturallySpeaking’s Vocabulary Editor

When you first transcribe your audio, you may find that Dragon NaturallySpeaking
misinterprets certain words and acronyms. In the sample recording used for this document, for
example “SIGDOC” (pronounced “sig doc”) is typically transcribed as “sick.” and ACM is
transcribed as “ACN” or “ICM”. To prevent this from happening “SIGDOC” and “ACM” will need
to be added to Dragon NaturallySpeaking’s Vocabulary Editor.

To add a word to the Vocabulary Editor:
1. Inthe Dragon NaturallySpeaking menu, click Vocabulary->0pen Vocabulary Editor.

(S ‘= /‘ ‘ ? Dictation & Commands ~

DragonBar Profile Tools Vocabulary @ Audio Help

Now listening for...

Learn from specific documents...
Learn from sent e-mails...

Add new word or phrase...
Open Vocabulary Editor...

Import list of words or phrases...

Export custom word and phrase list...

2. A window containing a list of currently available vocabulary will be displayed. Click
“Add” to add a new vocabulary term.

V4 Vocabulary Editor | x |
Search for:
Close

Written form | Spoken form A

Vanek Vanek

vanes vanes

Vanessa Vanessa

VanFleet VanFleet

VanFossen VanFossen

Vang Vang

Vangie Vangie

Vanguard Vanguard

vanguard vanguard

vanguards vanguards

VanHorn VanHorn addy

Vanhorn Vanhorn Delete

Vani Vani

Vania Vania Train.

Vanier Vanier

vanilla vanilla Properties

Vaniga Vaniga

vanish vanish v Help
Display: | All words v
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3. You will be asked to enter two forms of the word: the spelled version and the spoken
form. For SIGDOC, the spelled version of the word, which goes in the first text field,
would be “SIGDOC”. The “spoken form”, which goes in the second text field, would be

o _* ”
sig doc”.
V74 Vocabulary Editor
Search for:
Close
Written form Spoken form A
kraft kraft
Kraft Foods Kraft Foods
Krag, agen

spoken form

Spell or type the word|; dd to the vocabulary: Spoken form (if different):

SIGDOC

’sig doc

[]1 want to train the pronunciation of this word or phrase

Add Cancel Help

2 » Deere
Krakow Krakow
Krakowski Krakowski Train
Kral Kral
Krall Krall Properties
Kram Kram
Kramden Kramden v Help

Display: | All words v

4. Ifthe “Add” button is dimmed after you've added both the spelled and spoken versions
of the word, this means that there is already an entry in the Vocabulary Editor that
matches the entry you are attempting to add.

V24 Vocabulary Editor
Search for:
Close
Written form Spoken form A
kraft kraft
Kraft Foods Kraft Foods
Kragen Kragen
S Add word or phrase ﬂ
Spell or type the word(s) to add to the vocabulary: Spoken form [if different):
SIGDOC sig doc }
[]1 want to train the pronunciation of this word or phrase
Add Cancel Help
: R DElEE
Krakow Krakow
Krakowski Krakowski Train
Kral Kral
Krall Krall Properties.
Kram Kram
Kramden Kramden v Help
Display: | All words v

Training Dragon NaturallySpeaking to recognize how you say certain words
In addition to adding words to the dictionary, you can also train Dragon NaturallySpeaking to

recognize how you say certain words. This can be helpful when you add a new term or when
there is a word or term that Dragon NaturallySpeaking is consistently getting wrong.
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To train Dragon NaturallySpeaking to recognize how you say a word:

1. Inthe Vocabulary Editor, search for the word you want to train. If it exists, select the

word you want to train and click the “Train” button on the right.
Vg Vocabulary Editor | x |

Search for:

SIGDOC Close

Written form

\ Spoken form
R SIGDOC

sig doc

Add...

Delete
“ Train...

Properties...

Help

Display: | Searching results

2. The “Train Words” dialog box will appear. Make sure your microphone is attached to
your computer and click “Go” to begin recording.

o

Vocabulary Editor

Search for:
SIGDOC Close
Written form Spoken form ‘
b I Train Words ﬂ

Click Go to begin recording your speech.

sig doc
(R (&
Cancel Help d
Done Done & Train Another ]ele
;in...
Properties...
Help

Display: | Searching results

3. Ifyour voice is being recorded correctly, you will see a green bar as you record. If you

don’t see this bar, you will need to check your microphone setup.
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V24

Vocabulary Editor

Search for:
SIGDOC Close
Written form Spoken form ’
+ET Train Words ﬂ
Please say:
sig doc
@
Pause Cancel Help d..
Done Done & Train Another B
iin...
Properties...
Help

Display: | Searching results

4. After you have recorded the word, click “Done”.

Ve Vocabulary Editor
Search for:
SIGDOC Close
Written form ‘ Spoken form |
+EE Train Words ﬂ
Please say:
sig doc
S— @
Cancel Help d.
“ Done Done & Train Another 2
iin...
Properties...
Help

Display: | Searching results

If the term you want to train does not exist, add the term, and check the checkbox next

to “I want to train the pronunciation of this word or phrase”. When you click “Add”, the
“Train Words” dialog box will appear. You can then train your word as described in the

previous steps.
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V24 Vocabulary Editor

Search for:
ACM Close
Written form Spoken form
ACM ACM
Acma Acma
Acme Acme
S Add word or phrase ﬂ

Spell or type the word(s) to add to the vocabulary: Spoken form (if different):
ACM AcH ‘

| want ta train the pronunciation of this word or phrase

~ Add Cancel Help

DElEE

Train.
Properties
Help
Display: | Searching results v
V24 Vocabulary Editor
Search for:
ACM Close
Written form Spoken form ‘
ACK s
+ Train Words ﬂ
Acn
Acm  Click Go to begin recording your speech.
acm
s [ACM
]
d..
Done Done & Train Another e
in...
Properties...
Help
Display: | Searching results v

Re-transcribe the audio file

Once you've trained the words that Dragon NaturallySpeaking was getting wrong most
frequently, you will want to re-transcribe your audio file using the steps in “Transcribe the
audio file with Dragon NaturallySpeaking”.

Read the transcript and make final corrections

Dragon NaturallySpeaking will generally do a good job of creating transcriptions, but it is not
perfect. Even with training, some corrections to the transcript will be needed to getitto a
finished state.

To complete the transcription process:
1. Read the transcript in DragonPad, making corrections where necessary.
2. Export a text file containing the transcript, as described in “Exporting a text file
containing your transcribed text”.
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External Tools and Accessibility
VoiceThread

VoiceThread offers VoiceThread universal, which is an alternative VoiceThread interface
“specially designed to be used with screen-reading software and other assistive technologies”
[VoiceThread Accessiblity home]. It can be viewed here.

VoiceThread Universal

VoiceThread is an application designed for people to have discussions about shared digital media. [ Please choose a thread:
Each VoiceThread discussion consists of slides - just like a presentation - and each slide contains a
piece of digital media, like an image, video, or document. These slides can be commented on by ABE Test for Voice Thread
anyone with permission to access to the VoiceThread discussion.

Go to My Threads

Sign out of this account (elodesign @iastate.edu)

VoiceThread Universal Guide

Use VoiceThread Universal as my default site

Go to My Account Personal Introductions

Visit the Standard VoiceThread Site Go back to main category listing.

1. The first page you see 2. The “My Threads” page
Personal Introductions Personal Introductions - Slide 1.
Start playing this thread. Thread overview
Slide 1. ﬁ
Back to previous list.
French 378
French Film
. Studies in English
3, A VoiceThread — 71 1
Madisun says
Michelle Schoening says
Elli Rigolle says
Paige says
megan says
Shane Cooney says
Brittany says
kevin says
Allison says

Sylvina says

More comments

Add a new text comment

Add a new voice comment

Go back to the thread overview.

4. A VoiceThread Slide

VoiceThread and Captioning
You can add captions to VoiceThread files within VoiceThread. You have to have editing rights
to do so, so commenters can’t add captions to video or audio comments.

From VoiceThread help:http://docs.voicethread.com/web-application /accessibility-web-

application/closed-captioning/
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How to add a caption file

Only the person who created a VoiceThread or someone who has editing rights for that
VoiceThread may add captions to a video slide.

1. Navigate to the slide that contains the video.

2. Hover your mouse over the video icon on the left side of the page.

3. Click on the CC button in the drawer that slides out.

Slide1 &

4.

5. Click “Add captions”.

6. Selectyour caption file.
7

Click “OK”.
File types accepted
e DFXP
e SRT
e SAMI
e SCC
e SBV

Viewing captions

Captions will always be displayed when you are viewing a VoiceThread slide at VT
Universal. If you're viewing the slide from the standard VoiceThread site, turn on closed
captioning by clicking on the “CC” button in the top-right corner of the VoiceThread, and

selecting “On”.
7l VoiceThread g © 1 X
o Off
On

Edit captions...

Dictation

With Dictation, you can use your voice instead of typing text. Use these steps to turn Dictation
on or off:

1. From the Apple menu, choose System Preferences

2. From the View menu, choose Dictation and Speech to view Dictation Preferences.

3. Click On to enable Dictation, or Off to disable it
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Table 1. Do-it-Yourself (DIY) Closed Captioning Software Specifications

Tools Auto MP3 | MP4 | Timecode & Languages | OS [Pros Cons
Transcribe Sync
YouTube. Free | X X X Web |Cost free and easily available. All you |Can take time to render the video.
need is a Google account. The larger the size of the video, the
Easy to edit transcription and time longer the render time.
codes with built in tools 80% transcription accuracy if
Downloadable transcripts in different (standard English. The accuracy
formats (.vtt, .srt, .sbv) level decreases with the technical
Transcripts with time codes can be complexity of the language.
downloaded and imported into other |Not reliable - inconsistent time
video streaming service, like Vimeo taken to render files and in some
instances failed to produce a
transcript.
Searchable even if unlisted or mad
private.
Vimeo. X Web |Vimeo has a free and a paid version. No transcribing service
Free and Paid Both versions support closed No auto transcribing
versions captioning Will need other tools to create
closed captions
Dragon X X English, WIN |Efficient and quick WIN only
Naturally French, Trainable
Speaking German, Supports multiple user profiles that
Premium [talian, can be shared on more than 1
Spanish, computer.
Dutch,
Japanese
Camtasia X X X WIN |Create, sync, and export captions WIN only
Free 30-day
trial. $199
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Built-in MAC |No set up required - it comes with OS
Dictation Tool

for MAC

Naturally MAC

Dictate
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